
CCA-101: Fundamentals of IT & Programming 

Assignment -1 

1. What are the four fundamental parts of computer? Explain it with the help 

of daigram. 

 

The four fundamental parts of computer are :-- 

a) Input device 

b) Control unit 

c) Output device 

d) Memory unit 

 

 

 

 

 

 

 

 

 

 

2. Discuss about the the classification of computers based on size and 

capacity. 

 

Classification of computer : 

 Based on size and capacity, computer are classified as::  

Super computer 

Mainframe computer 

Mini computers 

Micro computers 

 

Input 

device 

Central processing unit 

Control unit 

Arithmetic/Logic unit 

Memory unit 

Output device 



Super computer: 

 Super computers are the most powerful and physically the largest 

by size. 

 These are systems designed to process huge amount of data. 

 The fastest super computers can perform over one trillion in a 

second. 

 Super computer have thousands of processors’ 

 Because of their estraordinary speed, accuracy and processing 

power, super computers are well suited for solving highily 

complex problem and huge amounts of calculations. 

 Example : JAGUAR, ROADRUNNER 

  

 

 

 

 

 

Mainframe computer: 

 Mainframe computer are very large filling an entire room and can 

process thosand of millions of instrution per second. 

 In mainframe environment, user connect to the mainframe 

through the many terminals wired to the mainframe. 

 Mainframes are capable of supporting hundreds to thousand of 

users simultaneously. 

 Some of the functions performed by a mainframe include:  flight 

sheduling, reservation and ticketing for an airline etc. 

 Example: 1BM mainframe Z13, 1BM 

system Z9 

 

Mini computers: 

 Mini computers are much smaller 

than mainframe. 

 These computers are also less expensive. 



 Some time referred to as midrange server or midrange 

computer. 

 They are typically larger, more powerful and more expensive 

than desktop commputer. 

 Midrange computers are usally used by small and medium 

sized bussiness as their servers. 

 User conect to the server through a network by using desktop 

computers. 

 Example: Apple ipod, 

CDC 160 A 

 

 

 

 

 

 

Micro Computers: 

 Micro computers are the  most frequently used  type of computer . 

 It is also known as personal computer (pc). 

 A micro computer is a small computer system designed to be used by 

one person at a time. 

 Example: Desktop computer, laptop 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

3.  What is the meaning of computer generation? How many computer 

generations are defind? What technologies were/are used? 

 

 

Generation is caracterized by dramatic improvments over the previous 

generation technology used to build computers, in terms of the internal 

organization of computer and progamming lanuages. 

 

 Computer generations are defind into five generation 

i. First generation 

ii. Second generation 

iii. Thrid generation 

iv. Fourth generation 

v. Fifth generation 

 

The computer generations or technologies used were/are :-- 

i. First generation – Vaccum tubes 

ii. Second generation – Transistors 

iii. Thrid generation – Integrated circuits 

iv. Fourth generation – Microprocessor 

v. Fifth generation – Artificial intelligence 

 

4. Differentiate between volatile and non-volatile memories. 

 

 

Volatile memory :-  

 Volatile memory is a computer storage that only maintains its data 

while the device is powerd. 

 Example:   RAM (Random access memory) is volatile. 

When we can working on a document, it is kept in RAM, and if the 

computer losses power your work will be lost. 

 



Non-volatile memory:-  

 Non-volatile memory is a type of computer memory that has the 

capability to hold saved data even if the power is turned of. 

 Example:  ROM( Read only memory), Harddisk, Floppy disk, etc. 

 

 

5. Distinguish among system software, application software and open source 

software on the basis of their features. 

 

 System software:-- 

 It is a type of software is designed to run a computer’s 

hardware and application programs. 

 Software like oprating system systems, compiler, editers and 

drives etc come under this category. 

 A computer can not function without prsence of system 

software. 

 If we think computer sustem as a layered model, the system 

software is the interface between the hardware and user 

applications. 

 

 Application software:-- 

 It is software created for a specific purpose used by end users. 

It can be called an application or simply an app. 

 Examples:  Word processor, accounting application, a web 

browers an email clint, media player etc. 

 

 Open source software:-- 

 It is a type of computer software in which source code is 

released under a license in which the copyright holder grants 

users right to study, change and distibute the software to 

anyone and for any purpose. 

 The Linux operating system is the best known examples of 

open source software. 

6. a) Create a file in MS-word to insert a paragraph about yourself and save it with file name“yourself”. 

Describe all steps involved in it. 

Q6 b) Write steps regarding followings 



 To change the font style 

 To change the font size 

 To change the font color 

 To highlight (in yellow) the line that reads “need to get IMS’s address”. 

(a) Video provides a powerful way to help you prove your point. When you click Online Video, you can 

paste in the embed code for the video you want to add. You can also type a keyword to search online for 

the video that best fits your document. 

(b) 

i. To format the font style:- 

 Select the text you want to modify. 

 Left-click the drop-down arrow next to the font style box on the 

home tab. The font style drop down appears. 

 Move your cursor over the various font styles. A live preview of 

the font will appear in the documet. 

 Left-click the font style you want to use. The font style will appear 

in the document. [Garamond] 

ii. To format the font size:- 

 Select the text you want to modify. 

 Left-click the drop-down arrow next to the font size box on the 

home tab. The font size drop down appears. 

 Move your cursor over the various font sizes. A live preview of the 

font size will appear in the documet. 

 Left click the font size you want to use. The font font size will 

change in the document. [12] 

iii. To format the font color:- 

 Select the text you want to modify. 

 Left-click the drop-down arrow next to the font color box on the 

home tab. The font color menu appears. 

 Move your cursor over the various font colors. A live preview of 

the color will appear in the documet. 

 Left-click the font color you want to use. The font color will 

change in the document. [Light green] 

iv. To change the highlight (in yellow) the line that reads “need to get IMS’S 

ADDRESS”:- 

 Select the text you want to modify. 



 Left-click the drop-down arrow next to the text hightlight color on 

the home tab. The text highlight color appears. 

 Move your cursor over the various highlight color. A live preview 

of the color will appear in the documet. 

 Left-click the yellow highlight color.  “need to get IMS’s adress” 

7. Create a file in MS-Word for the following document and save it with file name ‘ms_word’. Describe all steps 

involved in it. 

MS Word is a widely used commercial word processor developed by microsoft. 

MS word is application software, which is capable of  

 creating , 

 editing, 

 saving, and 

 printing any type of document 

a) To format the font style:- 

 Select the text you want to modify. 

 Left-click the drop-down arrow next to the font style box on the 

home tab. The font style drop down appears. 

 Move your cursor over the various font styles. A live preview of 

the font will appear in the documet. 

 Left-click the font style you want to use. The font style will appear 

in the document.  

 Style- “Century” [MS WORD] 

b) Creat wrong line:- 

 Select the text or line. 

 Click on home tab. 

 Click on abc (strikethrough) on font group. 

c) To format the font color:- 

 Select the text you want to modify. 

 Left-click the drop-down arrow next to the font color box on the 

home tab. The font color menu appears. 

 Move your cursor over the various font colors. A live preview of 

the color will appear in the documet. 

 Left-click the font color you want to use. The font color will 

change in the document. [Orange, Aqua accent 5, Orange accent 6] 



d) To use Bold, Italic, or underline commands:- 

 Select the text you want to modify. 

 Click the Bold, Italic, or Underline command in the font group 

on the home tab. 

  



e) To use a symbol as a bullet:- 

 Select an existing list. 

 Click the bullets command. 

 Select define New Bullet from the list. The define New Bullet 

dialog box appears. 

 Click the symbol button. The symbol dialog box appears. 

 Click the font: drop-down box, and select a font category. 

 Left-click a symbol to select it. 

 Click ok to apply the symbol to the list in the document. 

8. Create a file in MS-word for the following document and save it with file name ‘equations’. Describe all steps 

involved in it. 

  

  

  

  

 Click on insert tab, symbol group. 

 Click on equation down arrow button. 

 Click on Insert new equation. 

 A dialog box will appear. 

 Select script on structure group. 

 

9. Create a file in MS-word that convert existing highlight text to table as shown below and save it as 

file name ‘text_to_table’. Describe all steps involved in it. 

 Select the table you want to convert. 

Select the Insert tab. 

Click on Table command. A dialog box appears. 

Click on Convert Text to Table, a new dilog box appears. 

Here set number of columns. 

Click on OK, Finally selected text convertin a table. 

  

Select the table you want to convert. Select the Insert tab. 

Click on Table command. A dialog box 
appears. 

Click on Convert Text to Table, a new 
dilog box appears. 

Here set number of columns. Click on OK, Finally selected text 
convertin a table. 

  



10. Create a file in MS-Word to insert a table in the document. Describe all 

steps involved in it. 

   

    

    

    

    

    

To insert a table:- 

 Place your insertion point in the document where you want the table appear. 

 Select the insert tab. 

 Click the table command. 

 Drag the mouse over the diagram squares to select the number of columns and 

rows iin the table. 

 Left click your mouse, and the table appears in the document. 

 Enter text in to the table. 
 

 

11. Create a following worksheet in MS-excel and save it with name ‘book1’. 



 

 

 

 

 

Q12. Calculate the following things of a range (C2:C11) of data in the worksheet created in 

question no 10. 

 the sum of the marks using AutoSum in a range of cells (C2:C11) 

 average of the marks in a range of cells (C2:C11) 

 highest marks in a range of cells (C2:C11) 

 minimum marks in a range of cells (C2:C11) 



 

13.a) Q13 a) Describe various steps involved in the following 

 

 

et 

 To modify column width of a worksheet:- 

 Left-click the column heading of a column you want to modify. 

The entire column will appear highlight. 

 Click the format command in the cells group on the home tab. A 

menu will appear. 

 Select column width to enter. 

 A specific column measurment 

 Select Autofit column width to adjust the column so all the text 

will fit. 

 

 

 To modify row hight of a worksheet:-  



 Left-click the row heading of a row you want to modify. The 

entire row will appear highlight. 

 Click the format command in the cells group on the home tab. A 

menu will appear. 

  Select row hight to enter. 

 A specific row measurment 

 Select Autofit row hight to adjust the row so all the text fill it. 

 

 

 To delete row and columns of a worksheet:- 

 Select the row or column that you want to delete. 

 Click the delete command in the cells group on the home tab. A 

menu will appear. 

 Select sheet row or sheet column. 

 

b) Absolute reference and relative referance in formula:- 

 Select the cell where you want to write the formula ( in this example, H2). 

 Type formula = F3*$C$2. 

 Copy the formula into H3. The new formula should read = F3*$C$2. The F2 

reference changed to F3 because it is a relative reference but C2 remain 

constant because you created on absolute reference by inserting the dollar 

signs. 

 

Cell Address 

 Each rectangle in worksheet is called a cell. 

 Each cell has a name,  or a cell address, Based on the column and row where it 

is located. In below digram name of selected cell is A1 because column head  

is  A and row head is 1. 

 

14(a). What tools are available to costomize our PowerPoint presentation? 

 Tools are : 

1. Templates and Themes 

2. Slide Layouts 

3. Fonts 

4. Color Theams 

5. Icons 



6. Shapes 

7. Stock Photos 

8. Charts and Graphs 

9. Maps 

10. Tables 

11. Flowcharts 

12. Icon Charts 

13. Radials 

14. Progress Bars 

15. Animation 

16. Transitions 

17. Intracivity 

18. Audio and Video 

 

 (b). 

   Open a blank presentation: 

 Select the file tab to go to backstage view. 

 Select open. Clicking Open. 

 Select computer, and then click Browse. Alternatively, you choose 

OneDrive to open files stroed on your OneDrive. 

 The open dialog box will Appear. 

 

Save the presentation:  

 Locate and select the save command on the Quick Access Toolbar . 

 If you’re saving the file for the first time, the Save As pane will appear in 

backstage view. 

 You’ll then need to choose where to save the file and give it a file name. 

 The Save As dialog box will appear. 

 Save the presentation as Lab1.pptx 

 

Add a title to the first slide: the name of your collage 

 Click  on the title. 

 Type the text as you want. 

 If neccessary, press [Return] or[Enter] to move to a new file. 

 

Type your first name and last name in the subtitle selection 



 Click on title slide. 

 Click on subtitle. 

 Type the text [first name and last name]. 

 

Add a new slide which has a title and content 

 On the home tab, click the new slide button group. 

  PowerPoint adds a blank slide to your presentation. 

 

15. Write steps for creation of a set of PowerPoint slides that demonstrates your 

skill to use the tools of PowerPoint. It should include the following things 

 Title slide & bullet list 

Title slide :--  

 On the home tab, click the new slide button group. 

 Click on title only. 

Bullet list:-- 

 Select an existing list. 

 Click the bullets command on paragraph group. 

 Select define New Bullet from the list. The define New bullet 

dialog box appears. 

 Inserting Excel Sheet 

 In PowerPoint, Select the Insert tab & Click the Insert tab. 

 Click the object command in the text group. 

 A dialog box will appear. 

 Locate and select the desired Excel file, then click Insert. 

 Clip art and text 

Clipart 

 Select insert, pictures, Online pictures. 

 Type a word or phrase to describe what you’re looking fpr, then press 

enter. 

 Filter the results by Type for Clipart. 

 Selecct a picture. 

 Selecct insert. 

Text 

 Select insert, Click text. 

 Click text box. 

 On the slide, click the location where you want to add the text box. 

 Type your text on the text box. 



 Slide show effect 

 Select the slide you want to add a transition to. 

 Select the Transitions tab and choose a transition. Select a transition to see 

a preview. 

 Select Effect Option to choose the direction and nature of the transition. 

 Select preview to see what the transition looks like. 

 

Part – 2 

 

 

 

16. What is the difference between Machine Language and High Level Language? 

 

Machine language 

 A computer programming language consisting of binary instructions 

which a computerr can respond to directly. 

 Machine language is a collection of binary digits or bits that the computer 

reads. 

 A computer cannot directly understand the programming language used 

to creat computer programs, so the program code must be complied. 

 Ex: 01001000, 01100101, 01101100, etc 

 The language make fast and efficient use of the computer. 

 It requires no translator to translate the code. It is a directly understand by 

the computer. 

 All memory address have to be rembered. 

 

High Level Language 

 A high level language is a programming language that enables 

development of a program in a much more user friendly programming 

context. 

 This language is a programming language with strong abstraction about 

the details of the computer in contrast to low level programming 

language. 

 Ex: C, C++, Java 

 High level languages are grouped in two categories based on execution 

model – compiled or interpreted language. 



 High level language are programmer friendly, they are easy to 

write,debug and maintain. 

 It provied higher level of obstraction from machine language. 

 It takes additional translation time to translate the source code to machine 

code. 

 High level program are comparatively slower than low level program. 

 

17. Discuss about different type of C programming language. 

  

Different type of C programming language are:- 

I. Basic Data Type :- Floating-point, integer, double, character 

II. Derived Data Type:- Union, structure, array, etc 

III. Enumerated Data Type:- Enums 

IV. Void Data Type:- Empty value 

V. Bool Type:- True or false 

 

 

18. Find the output of the following expressions 

   

a) X= 20/5*2+30-5 

Output = 32 

b) Y= 30-(40/10+6)+10 

Output = 30 

c) Z= 40*2/10-2+10 

Output= 16 

19. Describe the syntax of following statements. 

a. If – else statement 

if (expression) 

{ 

true Block of statement 

} 

else 

{ 

Else Block of statement 

} 

 

Condition 

If code 

else code 



 

 

b. for Loop 

  

for (expression 1; expression 2; expression3) 

{ 

Block of statement; 

} 

 

c. while Loop 

 

while(condition) 

{ 

Block of statement 

} 

 

d. do while Loop 

 

do 

{ 

Single statement 

Or 

Block of statement 

} 

While (condition) 

 

20. find the output of the following program segments. 

a)  

#include <stdio.h> 

int main() 

{ 

int i; 

for (i=1; i<2; i++) 

{ 

printf( "IMS Ghaziabad\n"); 

} 

} 

B) 

#include <stdio.h> 

int main() 

{ 

int i = 1; 

while ( i <= 2 ) 



{ 

printf( "IMS Ghaziabad\n"); 

i = i + 1; 

} 

} 

c) 

#include <stdio.h> 

void main() 

{ 

int a = 10, b=100; 

if( a > b ) 

printf( "Largest number is %d\n”, a); 

else 

printf( "Largest number is %d\n”, b); 

} 

a) Output::  IMS Gaziabad/n 

b) Output:: IMS Gaziabad/nIMS Gaziabad/n 

c) Output:: Largest number is 100/n 
 


